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2.  GETTING STARTED 

2.1  Logging On 
 
Logging on to Trns·port PES involves four steps: 
 

1. Accessing the Remote Desktop Web Connection via the Internet 
2. Connecting to the server 
3. Logging on to the network 
4. Logging on to Trns·port PES 

 

2.1.1 Accessing the Remote Desktop Web Connection 
 
Double-click on the Internet shortcut on your desktop. 

 
In the address bar, type:  http://0501cotserv01A    
This will take you to the Remote Desktop Web Connection.   
 

Hint:  Save this location in your favorites so that it will readily accessible for when you 
need it again.  (Click on Favorites/Add to Favorites.)   
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2.1.2 Connecting to the Server 
 
In the Remote Desktop Web Connection dialog box, the server and size fields are pre-filled 
with the appropriate information.  Note that the size defaults to 800 by 600, with an option to 
select Full-screen.  Both options will be reviewed below. 
 

 
    
 

2.1.2.1 Connecting to the Server at 800 by 600 Option 
 
Important Consideration for using the 800 by 600 option: 
 
The size of your monitor and the resolution of your PC will influence how the application will 
look.  If your resolution is set to 1024 x 768 pixels or a number larger, the application will be 
very usable in this mode.  However, if your resolution is set to 800 x 600 or 640 x 480 pixels, 
you will probably rather use the remote desktop at the Full-Screen option (see 2.1.2.2  
Connecting to the Server at Full-Screen Option). 
 
To check your PC for resolution setting, right-click anywhere on your desktop and select 
Properties.  You can see the resolution of your PC on the Settings tab: 
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After clicking on the CONNECT button on the Remote Desktop Web Connection dialog box, the 
following screen will display: 
 

 
 
 
 

2.1.2.2 Connecting to the Server at Full-Screen Option 
   
At the Remote Desktop Web Connection dialog box, select Full-screen from the drop-down 
menu at the Size field and click on the CONNECT button. 
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The following screen will display:  
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note that with the Full-screen option, the remote desktop completely fills up your desktop 
window so that you cannot see your taskbar at the bottom.  You cannot see if you have new 
email arriving, or the PC clock, or any of your other processes. 
 
If you need to access your other processes, click on the Minimize button at the top of the screen: 
 
 

 
 
 
 
 
The Minimize button will place the Trns·port application as an icon in your taskbar (see 
following page): 
 
 

Minimize button 
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Note that you can now see your taskbar and work with other applications as needed.  Note also 
that the remote desktop has vertical and horizontal scrollbars. 
 
To restore the Remote Desktop Web Connection to full-screen, simply click on the minimized 
icon.   
 
 
 

Minimized Remote Desktop 
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2.1.3 Logging on the Network 
 
Whether using the 800 by 600 option or the Full-Screen option, the next step is to log on to the 
network.  Begin by clicking on the OK button to close the VDOT Terminal Server User Policy 
window. 
 
The Log On to Windows dialog box will open. 
 
Log on with your Network user name and password (the same user name and same password you 
use each day to log on to your PC.)  Click on the OK button. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Virginia Department of Transportation Usage Policy statement displays (see following 
page).  Click on the OK button to indicate you agree with the information.  
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2.1.4 Logging on Trns·port PES 
 
Double-click on the PES icon. 
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An Enter User Information dialog box displays. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

Enter your user Trns·port PES User ID in the User ID field.  Enter your password in the 
Password field.   
 
The password shall be at least six and not more than thirteen characters.  It may consist of letters 
and/or numbers.  Click the OK button with the mouse or press [ENTER].   
 
 

2.2 Logging Off 
 
To completely log off, you should: log off Trns·port; disconnect from the remote connection; and 
close the Internet. 
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2.3. Logging Off Trns·port PES 
 
You may log off Trns·port PES by selecting File, Exit, or you may click on the X in the upper 
right corner of the Trns·port window.  
 

 
 
 
A window displays that asks if you are sure you want to exit the application. Click the  
OK button.  (If you do not wish to exit, click the CANCEL button.) 
 
 

 
 
 
 



 
VDOT Trns·port PES User’s Manual December 1, 2011 2-10 

2.3.1 Disconnecting from the Remote Desktop Web Connection 
 
DO NOT CLOSE THE REMOTE DESKTOP WEB CONNECTION 
WINDOW BY CLICKING ON THE X IN THE UPPER RIGHT CORNER. 
 
It is important that you disconnect from the Remote Desktop Web Connection using the START 
button.   If you do not disconnect properly, your session will remain activated until it times out or 
until the Help Desk is contacted to terminate the session. 
 

NOTE:  As you can see by the screen print below, you may have two START buttons  – 
one for Remote Desktop Web Connection, and one for your computer’s operating 
system.  Be sure to select the START button that is associated with the Remote Desktop 
Web Connection application, not the START button for your computer’s operating 
system.  You may have to scroll down to find the appropriate START button. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

This is the START button for 
Remote Desktop Web Connection. 

This is the START button for your 
computer’s operating system. 
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From the START button for  
Remote Desktop Web 
Connection, select Shut Down.   
 
 
 
 
 
Use this START button 

not this one 
 
 
 
 
 
 
 
 
 
 
The Shut Down Windows screen displays: 

 
 
 
 
 
 
 
 
 
 

 
 
 
 
Click on the OK button. The Remote Desktop Web Connection application will close. 
 
 

Log off John.Doe 
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2.3.2 Closing the Internet 
 
After logging off Trns·port PES and disconnecting from the Remote Desktop Web Connection, 
you will be returned to the Internet.  To close the Internet, select File, Close.  You may also close 
by clicking the X in the upper right corner of the window. 
 
 
             
 

 
 
 
 

  
 
 
 

Title Bar 
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2.4 Screens in Trns·port PES 
 
After logging on to Trns·port PES, a “blank palette” will be displayed.  The title bar, menu bar 
and button bar are located across the top of the screen.   
 

 
 
 
 

     
 

 
 

 

2.4.1. Title Bar 
 
The title bar contains the name of the application.  It shows the title Trns·port PES and the icon 
representing the program (a crane with the three letters P E S).  The title bar also has, at the right- 
hand side, the three buttons which allow you to minimize, resize and close the application. 
 

 
 
 

 
 Close 

Resize 
Minimize 

Menu Bar 

Button Bar 

Title Bar 
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2.4.2. Menu Bar 
 
The menu bar contains the menus File, Edit, View, Utilities, Window and Help.  By clicking on 
one of these options, you will see the available commands and processes associated to each. 
 

 
 
 

2.4.3. Button Bar 
 
The button bar displays icons of some of the most useful commands.  If the button bar is not 
displayed, it can be retrieved by selecting Show Toolbar from the Window menu. 
 
 - displays the listing of prime projects         

   
 - displays the listing of projects            
 
 - displays the listing of proposals 
 
 - displays the listing of bid lettings 

 
 - displays the listing the vendors 

 
    

As you rest your mouse pointer over an icon, the name/function of the icon will be displayed.  
This function is known as “power tips”.  To reinstate this function should it be turned off, place 
your mouse anywhere on the button bar, right-click the mouse and select Show Power Tips. 
 
If you wish to see text with the icons on the button bar, place your mouse anywhere on the button 
bar, right-click the mouse and select Show Text.   Your button bar will now look like this: 
 

 
 
 
 
 

Button Bar  
with text shown 
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2.5. Case-Sensitive 
 
In the Client-Server version of Trns.port, many areas for input are case-sensitive; therefore, it is 
best to apply your Caps Lock throughout your session. 
 

2.6. List, Detail and Tabbed Folder Windows 
 
Trns·port displays information in three types of windows: 

- list windows 
- detail windows 
- tabbed folder windows 

   

2.6.1 List Windows 
 
A list window is displayed when you first access Trns·port and select one of the buttons (i.e. 
Projects).  List windows contain lists of records for a type of data.  From a list window, you can 
select a specific record and open it in a tabbed folder window. 
 

 
 
 

Typical List Window 
 



 
VDOT Trns·port PES User’s Manual December 1, 2011 2-16 

2.6.2 Detail Windows 
 
The detail window contains fields and data associated with a specific record.  The prime project 
detail window is an example (see next page).  
 
NOTE:  Detail windows should be used only when tabbed folder windows are unavailable.  
Tabbed folder windows should always be used when available, as any future enhancements shall 
be made only to them.   

 
 
 

Typical Detail Window 

2.6.3 Tabbed Folder Windows 
 
The tabbed folder window will display all the data and fields of a record and will allow you to 
add, change or browse.  Although there are various ways to navigate in Client Server, it is 
recommended that you access the tabbed folder windows, where applicable.  Any future 
enhancements made by InfoTech will be made only to the tabbed folder windows.  No critical 
information will be lost if you restrict your activities to the tabbed folders. 
 
There are several ways to open a tabbed folder window.  Each user will find the method he/she 
prefers.  While some users like to use the right-click of the mouse, others might prefer to access 
menus through the menu bar and others might prefer to double-click.    
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Listed below is an example of several ways to open the screen (tabbed folder window of a 
project) shown on the following page: 
 

1. Highlight the desired record at the list window.  Right-click and select Tabbed Folder 
Change. 

2. Highlight the desired record at the list window.   From the menu bar, click on Edit and 
then click on Tabbed Folder Change. 

3. Double-click on the highlighted record.  
 
Note:  For simplicity, this manual will lead the user through the commands by describing the 
right-click of the mouse, when applicable, and by accessing records through the Tabbed Folder 
Windows. 

 
 
 

Typical tabbed folder window 
 
When in a tabbed folder window, click on the tab labels to display the information on the various 
tabs.  Tabs that consist of more than one page have radio buttons so that you can access each 
page.   
 
When you finish entering the information on a tab, click the OK button, if available.  However, 
this does not save the information permanently.  Before leaving the tabbed folder window, you 
must save all the changes you have made to the database by clicking on the SAVE icon         or by 
selecting Save from the File menu.   
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2.6.4 Grid and Detail Areas 
 
Some tabbed folder windows contain both a grid and a detail area.  (See the following page for 
an example.)  You can enter information on this type of window in one of two ways: 
 

o Right-click in the window and select Show Detail to display the detail area if it is not 
currently displayed.  Enter information into the fields of the detail area (bottom half of 
the screen). 

o Right-click in the window and select Hide Detail.  Enter information directly into the 
cells of the grid (top half of the screen). 

 

 
 
 
On the tabs which contain a Grid and Detail area, a “quick find” search box is displayed at the 
top of the window.  By double-clicking on any column heading, the find box will search under 
that column based on the search criteria you enter in the box.  For example, in the screen shown 
above, if you were to double-click on the Description column heading, the label of the find box 
would change from Find Category to Find Description. 
 

Detail Area 

Quick Find Search Box 
Grid Cells 
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2.6.5 Split Horizontal Scrolling 
 
Since the columns of the grid area cannot all be shown on the screen, a scroll bar is provided at 
the bottom of the grid area.  You can divide a grid into two regions that scroll independently of 
each other.  This feature, known as “split horizontal scrolling”, allows you to leave one or more 
columns fixed in one half of the grid, while being able to scroll through the rest of the columns in 
the other half of the grid.  It works much like Freeze Panes in Microsoft Excel. 
 
To use this feature, position the mouse pointer over the small vertical black bar at the left end of 
the horizontal scroll bar. 
 

 
 
 
The mouse pointer changes to a double-headed arrow.  Press and hold the left mouse button and 
drag the mouse to the right to create a new horizontal scrolling border.  When you release the 
mouse button, you will have two independently scrolling regions in the grid. 
 

Position mouse 
pointer here 
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2.7. Entering Dates 
 
Dates are shown in Trns·port in MM/DD/YYYY format.  Fields to be filled-in with a date are 
shown at a default value of  00/00/0000. 
 

 
 
Dates may be entered in two ways: 
 

o Simply type over the zeroes ignoring the slashes.  For example, if you were to enter the 
date December 28, 2003, you would type 12282003.  The numbers you type will 
overwrite the zeroes and will skip over the slashes. 

 

 
 

Two 
independently 

 scrolling regions 
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o If the date field displays a clock icon        to the right, the icon may be clicked to open a 
calendar.  Click on the arrow      to advance to future months/years, if necessary.  Select 
the desired date and click on the OK button. 

 

 
 

2.8. Working with Filters (Searching) 
 
Trns·port is equipped with a filter to help you search for records in reference tables and list 
windows.  Click the FILTER icon         to display a Filter window.   
 

 
 

There are three fields (Column, Operator and Value) from which you can specify the 
information you wanted filtered. 
 

Column:  The Column Field contains the names of the most commonly used columns 
in the table from which the list window is built.  Click on the down arrow to 
choose from the list. 

 
Operator: The Operator Field contains operators to narrow your filter: 

Equal to (=) Greater than (>) Is not null      
Greater than or equal to (>=) Less than (<) Is null 
Less than or equal to (<=) Contains Like  
Not equal to (< >) Does not contain Not like 
 

Click on the down arrow to choose from the list.

Click on the 
clock icon to 
access the 
calendar. 
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Value: In the Value Field, type in the filter criterion you are using as a delimiter or 
are trying to match. 

 
 
EXAMPLE:  From the listing of projects, if you wanted to find all projects with the PCN 
(Project Number) containing the numbers “00001915”, you could set up your filter as shown 
below: 
 
 

 
 
 
 

Click on the OK button and the list will be re-displayed with results based on your filter criteria: 
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 2.8.1 Working with the Advanced Filter 
 
The Advanced Filter lets you search for data using a more complex chain of criteria.  From the 
Filter window, click on Advanced.  The Advanced Filter window displays.  In this window, 
you can give numerous combinations of conditions to filter, with operators, values and logicals. 
 

 
 
 
Construct each condition by choosing a value in each of the Column, Operator and Value 
fields.  Click the ACCEPT button, and the conditions will be displayed in the Select Where area of 
the window and in the order in which you created them. 
 
After you create all the conditions, combine them into a “where clause” by selecting from the 
drop-down arrow of the And/Or column to the right of each condition.  Typically, all lines 
requiring Or should be combined before the lines requiring And.  Use the logical options (+  and 
(-  to override the And/Or combinations where necessary. 
 
The Advanced Filter window contains an INSERT ROW, an ADD ROW and a DELETE ROW button to 
aid in the entering and arranging of your “where clauses”. 
 
An example of an advanced filter is shown on the following page, with the steps used to create it: 
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EXAMPLE OF ADVANCED FILTER:   
 
If you are entering the bid items for your category and are searching for PAVEMENT ITEMS, 
which fall between numbers 10000 and 11999, follow these steps: 
 
 

1) Create your first “where” condition by selecting values in each field (as shown in the 
screen below) and clicking the ACCEPT button.  The condition you built will be displayed 
in the Select Where area of the window. 

 
 

 
 

is 
placed 
here  . 

The 
condition 
you type 
here 
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2) Click on the ADD ROW button to add a row to the bottom.   

3) Highlight that row by clicking in it.   

4) Create your second “where” condition (as shown in the screen below) and click the 
ACCEPT button.  This second condition will be displayed in the Select Where area of the 
window: 

 
 

 
 

Create  
your 
condition 
here 

Condition 
is placed 
here  . 
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5) Next, combine the conditions into a “where clause” by selecting from the drop-down 
arrow in the And/Or column to the right of each condition line. 

 

 
 

6) Click the APPLY button to run the filter.  You will be asked if you wish to save changes.  
You may either save the filter with a name or choose not to save the filter.   

 
7) The results will be displayed.  All items not matching the criteria you specified will be 

filtered out and you will be left with results fitting your search criteria. 
 

 
 

 

Select  
And/Or 
where 
applicable 
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2.8.2 Saving and Deleting Filters 
 
You can save a filter with a unique name.  If there are particular types of items you search for 
frequently or specific areas within the item code database you use, you may wish to save the 
search criteria in a filter so that you do not have to recreate the filter continuously. 
 
When you finish creating the filter, enter a name for the filter in the Name field at the top of the 
Advanced Filter window.  The name can be 30 characters long.  Click on the OK button to save 
the filter.  When you wish to use the filter again, select the filter name from the drop-down menu 
and Trns·port automatically loads the filter parameters. 
 
Note that a filter saved for a search of a particular listing (i.e. project list) is available only at that 
listing. 
 
If you wish to remove a saved filter, select the filter name and click on the DELETE button. 
 
 

 2.8.3 Creating a Default Filter for Item Searches 
 
A good tool provided by Trns·port is the default filter.  The default filter is used at the Item Code 
Table listing (the listing of all available pay items). 
 
You can create one unique default filter to show only those items in the Item Code Table that 
you work with on a regular basis.   For instance, if you work almost exclusively with Traffic 
Control and Safety items, which fall between 50000 and 59999, you could create your default 
filter to display only those items when you access the item code listing. 
 
To create the default filter, open the Item List lookup window and click the FILTER icon.  On the 
Filter window that displays, click the ADVANCED button.  The Advanced Filter displays. 
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In the Name field, type Default and then enter the search criteria you want to use.  Click the 
SAVE button to save the default filter.  
 
 

 
 
 
 
 

DOE JJ 

DOE JJ 
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Starting with the next time you open the Item List lookup window, Trns.port will automatically 
filter the list of items according to the criteria in your default filter.  In other words, the entire list 
of items will not be displayed; only those you specified in your default filter. 
 
For those times when you need to override your default filter and see the entire list of items in 
the Item List, click on the SHOW ALL button at the Filter window. 
 
 

 
 
 

In addition to the default filter you create and save, you can also share the use of the filters 
created by other users in your control group.  On the Advanced Filter window, click on the 
radio button for Control Group.  Click the drop-down arrow by the Name field to see the list of 
available filters. 
 
 

2.8.4 Changing the Default Filter 
 
To change the criteria in your default filter, open the Item List lookup window and click the 
FILTER button.  On the Filter window that displays, click the ADVANCED button.  At the Name 
field, click on the drop-down arrow and select the Default filter assigned to you.  Make changes 
to the criteria as needed and click on the SAVE button.  Note that you can only change the default 
filter you created. 
 
 

2.8.5 Deleting the Default Filter 
 
To delete your default filter, open the Item List lookup window and click the FILTER button.  On 
the Filter window that displays, click the ADVANCED button.  At the Name field, click on the 
drop-down arrow and select the Default filter assigned to you.  Click on the DELETE button.  
Click YES in the Delete Confirmation window.  Note that you can only delete the default filter 
you created. 
 
 
 
 

SHOW ALL 
button 
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2.9. Sorting Information 
 
When viewing a list window, you can sort the data in any column.  Click on the Sort icon          
or from the Edit menu, select Sort.  The Sort window will display.  
 
 

 
 
 

You can choose which column to sort by and you can choose either Ascending (A-Z) or 
Descending (Z-A) for the selected column.   
 
Click on the APPLY button to sort the rows in the order you specified, or click on the CANCEL 
button to cancel and return to the list window. 
 
The Sort window also contains INSERT, ADD and DELETE buttons to aid in the entering and 
arranging of your sorting. 
 
The HELP button will display a help window with information about sorting. 
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2.10. Using Online Help 
 
To get online help, click on Help from the menu bar.  
Select Help Index.  The Help topics are arranged on 
three tabs:  Contents, Index and Search.  
 
 
 

2.10.1. Help Contents Tab 
 
The Help Index window opens on the Contents tab, which is most useful when you already 
know the section for which you want help.  It is organized by category and displays the list of 
topics available in the Help system in a Windows Explorer type window.  You can navigate the 
expandable/collapsible books and pages in the left pane of the window.  When you double-click 
on a book, it opens to reveal additional books and pages.  To access a topic, double-click on the 
desired page and the topic information appears in the right pane of the window. 
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2.10.2 Help Index Tab 
 
The Index tab lists keywords or phrases alphabetically.  It is useful when you need to search for 
a topic and the exact wording of the topic is not known.   Enter the first few letters of the desired 
search topic in the key-in text box.  The list scrolls to reveal matches for the keyword you 
entered.  Click a topic in the list to display the information in the right pane. 
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2.10.3 Help Search Tab 
 
The Search tab provides access to a rapid full-text search.  To use this tab to find a specific 
topic, enter the search word in the Section 1 key-in text box.  Section 2 displays words that 
match the results of the preliminary search completed in Section 1.  If the overall search still 
needs to be narrowed, select the best match from the list in Section 2.  Section 3 then displays a 
more specific list of topics.  Click the best topic match from the search results in Section 3 to 
display the information in the right pane. 
 

 
 
 

2.10.4  Help on Active Window 
 
From the Help menu, you may also select Help on Active Window.  Trns·port will display the 
Help Contents window already opened to help topics on the activity you are currently 
performing. 
 

2.10.5 About Trns·port PES 
 
If you choose About Trns·port PES from the Help menu, a window with general information 
about the application displays. 
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2.10.6 Field Help 
 
At any field in which you can enter data, you can right-click and select Field Help.  A window 
displays giving pertinent information about that field.  (To get field help for a field contained in a 
grid, click on the column header with the right mouse button and select Field Help.) 
 

For example, the screen below gives the information on the field Disres from the Project 
window.   
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